
 
 
 
 

LAMBDA 365 
  

 
 
 
 
 

 UV Express Software Users Guide 
 

 
 
 
 
 
 
 

 
 
 
 
 
 

UV-VIS SPECTROSCOPY 



 

 

 
 

Release History 

Part Number Release Software Version Publication Date 

09931274 G UV Express 4.1.1 February 2017 

 
Any comments about the documentation for this product should be addressed to: 

 
User Assistance   
PerkinElmer 
710 Bridgeport Avenue  
Shelton, CT 06484-4794 
U.S.A. 
  
Or emailed to: info@perkinelmer.com 
 
Notices 
The information contained in this document is subject to change without notice. 
Except as specifically set forth in its terms and conditions of sales, PerkinElmer 
makes no warranty of any kind with regard to this document, including, but not 
limited to, the implied warranties of merchantability and fitness for a particular 
purpose. 
 
PerkinElmer shall not be liable for errors contained herein for incidental consequential 
damaged in connection with furnishing, performance or use of this material. 
 
Copyright Information 
This document contains proprietary information that is protected by copyright. 
All rights are reserved. No part of this publication may be reproduced in any form whatsoever 
or translated into any language without the prior, written permission of PerkinElmer, Inc. 
 
Copyright © 2017 PerkinElmer, Inc. 
 
Trademarks 
Registered names, trademarks, etc. used in this document, even when not specifically marked 
as such, are protected by law. 
 
PerkinElmer is a registered trademark of PerkinElmer, Inc. 

 
 

 
 



 
 

 
Table of Contents 
 

I. INTRODUCTION ......................................................................................................... 1 

I-1. Overview ............................................................................................................................. 1 

I-2. Specifications of UV Express .............................................................................................. 1 

I-3. UV Express Software Interface ........................................................................................... 5 

I-3-1. Window Title ................................................................................................................. 5 

I-3-2. Main Menu .................................................................................................................... 5 

I-3-3. Menu Bar ...................................................................................................................... 5 

I-3-4. Toolbar .......................................................................................................................... 6 

I-3-5. Main Window & Spectral Display Function Tool ........................................................... 6 

I-3-6. Result window ............................................................................................................... 7 

I-3-7. Trace bar ....................................................................................................................... 7 

I-3-8. Monitoring Bar .............................................................................................................. 7 

I-3-9. Data/Method List ........................................................................................................... 8 

I-3-10. Spectrum List .............................................................................................................. 8 

II. FILE MENU ................................................................................................................ 9 

II-1. New ..................................................................................................................................... 9 

II-2. Open ................................................................................................................................. 10 

II-3. Close ................................................................................................................................. 11 

II-4. Close All ............................................................................................................................ 11 

II-5. Save .................................................................................................................................. 11 

II-6. Save As............................................................................................................................. 12 

II-7. Open Method .................................................................................................................... 13 

II-8. Save method .................................................................................................................... 13 

II-9. Export ............................................................................................................................... 14 

II-10. Print ................................................................................................................................ 15 

II-11. Exit .................................................................................................................................. 16 

III. EDIT MENU ............................................................................................................. 17 

III-1. Undo ................................................................................................................................ 17 

III-2. Cut ................................................................................................................................... 17 

III-3. Copy ................................................................................................................................ 18 

III-4. Paste ................................................................................................................................ 18 

III-5. Delete .............................................................................................................................. 18 



 

 

III-6. Select All .......................................................................................................................... 18 

IV. VIEW MENU ............................................................................................................ 19 

IV-1. Absorbance ..................................................................................................................... 19 

IV-2. Transmittance .................................................................................................................. 19 

IV-3. Reflectance...................................................................................................................... 20 

IV-4. Energy ............................................................................................................................. 20 

IV-5. Experimental Information ................................................................................................ 20 

IV-6. User Information .............................................................................................................. 20 

V. MEASURE MENU .................................................................................................... 22 

V-1. Zero .................................................................................................................................. 23 

V-2. Baseline ............................................................................................................................ 23 

V-3. Blank ................................................................................................................................. 23 

V-4. Sample ............................................................................................................................. 23 

V-5. Stop .................................................................................................................................. 24 

V-6. Go to Wavelength ............................................................................................................. 24 

V-7. Align .................................................................................................................................. 24 

V-8. Options ............................................................................................................................. 24 

V-8-1. File Save Method ....................................................................................................... 25 

V-8-2. Baseline Display ........................................................................................................ 25 

V-9. Lamps & Electrics ............................................................................................................. 26 

V-9-1. Lamp Status ............................................................................................................... 27 

V-9-2. Lamp Control ............................................................................................................. 27 

V-9-3. Lamp Monitoring ........................................................................................................ 28 

V-9-4. Power Monitoring ....................................................................................................... 28 

VI. METHOD MENU ..................................................................................................... 29 

VII. MATH MENU .......................................................................................................... 29 

VII-1. Area ................................................................................................................................ 30 

VII-2. Smoothing ...................................................................................................................... 31 

VII-3. Derivative ....................................................................................................................... 32 

VII-4. Scalar Add ...................................................................................................................... 32 

VII-5. Scalar Multiply ................................................................................................................ 33 

VII-6. Scalar Divide .................................................................................................................. 33 

VII-7. Log ................................................................................................................................. 34 

VII-8. Add ................................................................................................................................. 34 

VII-9. Subtract .......................................................................................................................... 34 

VII-10. Average ........................................................................................................................ 35 



 
 

VIII. WINDOW MENU ................................................................................................... 36 

VIII-1. Tile Horizontally ............................................................................................................. 36 

VIII-2. Tile Vertically ................................................................................................................. 37 

VIII-3. Cascade ........................................................................................................................ 37 

IX. HELP MENU ........................................................................................................... 38 

IX-1. Contents .......................................................................................................................... 38 

IX-2. About ............................................................................................................................... 38 

X. MEASUREMENT MODES ....................................................................................... 39 

X-1. SCAN Mode ..................................................................................................................... 39 

X-1-1. Scan Setup ................................................................................................................ 39 

X-1-2. Equation Calculation ................................................................................................. 47 

X-1-3. Find Peak/Valley ........................................................................................................ 51 

X-2. Quantification Mode ......................................................................................................... 55 

X-3. Kinetics Mode ................................................................................................................... 62 

X-4. Wavelength Program Mode ............................................................................................. 68 

X-5. Nucleic Acid Analysis Mode ............................................................................................. 72 

X-6. Protein Analysis Mode ...................................................................................................... 78 

X-7. Cell Density Mode ............................................................................................................ 87 

X-8. Thermal Denaturation Mode ............................................................................................ 92 

X-9. Scanning Kinetics Mode ................................................................................................... 97 

X-10. Scanning Quantification Mode ..................................................................................... 105 

XI. DISPLAY FUNCTION TOOLS .............................................................................. 113 

XI-1. Zoom In / Reset / Auto scale ......................................................................................... 113 

XI-2. Add / Edit / Delete Label................................................................................................ 114 

XI-3. Properties ...................................................................................................................... 115 

XI-4. Pick Peak / Valley .......................................................................................................... 116 

XI-5. Cursor / To left / To right ................................................................................................ 117 

 



 

 

PerkinElmer                                         UV Express Software User Guide  1 

I. Introduction 
 

I-1. Overview 
 

This manual provides step-by-step instructions for the use of UV Express software with a Perkin 

Elmer Inc. Double Beam UV-Visible Spectrophotometer.  

UV Express software must be installed onto a Microsoft® Windows 7 or Window 8 operating 

system to function properly. 

 

I-2. Specifications of UV Express 
 

Operating Environment 

Support Double-beam UV-Vis Spectrophotometer 

 

∙ Lambda 365 UV-Visible Spectrophotometer 

Control Accessories 

∙ 8 Position Multi Cell Holder  

∙ Water Jacketed 8-Position Multi-Cell Holder  

∙ Advanced Transmission Holder 

∙ Film Holder 

∙ Variable Angle Transmission Holder 

∙ Micro Cell Holder 

∙ Test Tube Holder 

∙ Variable Pathlength Cuvette Holder  

∙ Auto Sipper System with Software Control 

∙ Single Cell Peltier Holder (without heated reference or with heated reference) 

∙ 6-Position Peltier Controlled Cell Changer (without heated reference or with heated reference)

∙ Fixed Angle Reflectance Holder 

∙ Autosampler  

∙ 50 mm Transmission / Reflectance Sphere 

. Magnetic Stirrer Assembly (Auto Type) 

. Magnetic Stirrer Assembly (Manual Type) 
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Computer Requirements 

∙ Processor: Intel® Core 1.5 GHz or faster 

∙ RAM: At least 1GB 

∙ Hard disk: 50GB with 1GB free 

∙ Input device : Mouse and keyboard 

∙ Monitor: 1024x768 (minimum) 

∙ Media: CD ROM Drive 

∙ Port: USB port for the data acquisition 

Operating System 

∙ Microsoft® Windows 7 or Windows 8 

Output Device 

∙ Microsoft® Windows compatible printer 

 

Scan Mode 

Scan Setup 

∙ Measures Absorbance, Transmittance, Reflectance at the full or selected 
wavelength 

∙ Export to Clip board, CSV file, Excel file, BMP file, ASCII file, JCAMP file 
∙ Zoom In / Out, Add / Edit Labels 

Equation 

Calculation 
∙ Allows the user to enter support equations for the evaluation of the data 
∙ Supports Functions: +, - , /, *, ABS, Exp, LN, LOG10, SQRT 

Find/Peak Valley ∙ Find peaks or valleys automatically or manually 

Quantification Mode 

Quantification 

Standard/Sample

∙ Concentration Unit: All units user-specifiable  

∙ Fit Order: Linear, Quadratic, Cubic 

∙ Supports intercept of calibration curve  

∙ Calculation of correlation coefficient 

∙ Number of repeat measurements (1 to 5) to obtain a mean value 
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Kinetics Mode 

Time Based 

Kinetics 

∙ Monitors AU, %T continuously over time at a fixed wavelength 

∙ Time Unit: Min, Sec 

∙ Zero Order, Initial Rate, First Order, Delta AU 

Wavelength Program Mode 

Wavelength 

Program 

∙ Measure Absorbance, Transmittance, Reflectance at selected multiple 

wavelengths 

Bio Mode 

Nucleic Acid 

Analysis 

∙ General ratio with two wavelengths for the calculation of user specified 

ratios 

∙ Determine concentration of protein and nucleic acid using coefficients 

∙ Baseline Correction 

Protein Analysis 

∙ Predefined methods 

∙ Bradford Protein Analysis at 595 nm 

∙ Bicinchoninate (BCA) at 562 nm 

∙ Biuret Protein Analysis at 540 nm 

∙ Lowry Protein Analysis high sensitivity at 750 nm 

∙ Lowry Protein Analysis low sensitivity at 500 nm 

∙ Lowry Protein Analysis at 740 nm 

∙ Trinitrobenzene Sulfonate at 416 nm 

Cell Density 
∙ Predefined methods 

∙ Cell Density calculated with absorbance of 600 nm 

Thermal 

Denaturation 

∙ Temperature Unit: ºC 

∙ Temperature limit: from -5 to 100 ºC 

∙ Tm calculated with average method & 1st Derivative 

∙ User defied equation allows calculation from Tm value (ex: %G-C) 

  



 
 

4  UV Express Software User Guide                                         PerkinElmer 

 

Scanning Kinetics Mode 

Scanning 

Kinetics 

∙ Monitors AU, %T and %R continuously over time at a specified wavelength 

range 

∙ Time Unit: Min, Sec 

∙ Zero Order, Initial Rate, First Order, Delta AU 

Scanning Quantification Mode 

Scanning 

Quantification 

∙ Measures Absorbance, Transmittance, Reflectance at the full or selected 

wavelength 

∙ Concentration Unit: All units user-specifiable 

∙ Fit Order: Linear, Quadratic, Cubic 

∙ Supports intercept of calibration curve 

∙ Calculation of correlation coefficient 

Multi-Component Analysis Mode (Optional) 

Multi-Component 
Analysis 

∙ Analyze complex compounds containing multiple components (up to 4  

components) 

∙ Define the concentration of each component. 

System Performance Validation Software (Optional) 

Validation 

∙ Automatic Validation Wizard assists with the validation across the UV and 
Visible range 

∙ Includes Photometric, Wavelength, Resolution, Stray Light, Noise and 
Stability 
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I-3. UV Express Software Interface 
 

This chapter describes the unique display features of UV Express Software. 

 

 
 

I-3-1. Window Title 
 

Display the title of an active window or file. If data is saved as a specific file, its name will 

become the window title; otherwise, the title will be assigned automatically as [Untitled-1], 

[Untitled- 2], etc. 

 

I-3-2. Main Menu 
 

The Main Menu consists of a File Menu, Edit Menu, View Menu, Measure Menu, Method Menu, 

Math Menu, Window Menu and Help Menu. 

  

 

I-3-3. Menu Bar 
 

Create the icons of Scan Setup, Equation Calculation or Find Peak/Valley. 

 

 

 

 

 
Window Title Main Menu 

Menu Bar 

Monitoring Bar 
Spectral Display Function Tool 

Data/Method List 

Result Window 

Tool Bar 

Trace Bar 

Spectrum ListMain Window 
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I-3-4. Toolbar 
 

The toolbar provides quick access to basic commands without opening a menu. Users can 

modify the configuration of the toolbars as desired. 

Icon Command Hot Key Icon Command Hot Key 

 New Ctrl + N  Delete Del 

 Open Ctrl + O  Undo Ctrl + Z 

 Save Ctrl + U  Absorbance  

 Print Ctrl + P  Transmittance  

 Cut Ctrl + X  Reflectance  

 Copy Ctrl + C  Energy  

 Paste Ctrl + V    

 

I-3-5. Main Window & Spectral Display Function Tool 
 

Display the spectral data. If there are several spectra in the window, only an active red 

spectrum can be edited. 

Display the spectrum window and calibration curve in the quantification experiment. 

Display a main window as required. 

The following table provides a brief description of each Display Function Tool. 

Toolbar Command Description 

 Zoom Reset Reset the zoom area to the original size 

 
Y Axis Auto Scale 

Allow the auto scale of Y-axis depending on the 

measurement result 

 
Pick Peak Look for peaks. Use in Find Peak/Valley Mode 

 Pick Valley Look for valleys. Use in Find Peak/Valley Mode 

 Cursor Display the cross lines for selecting data points 

 To Left Move the cursor to the left 

 
To Right Move the cursor to the right 

 
Add Label Add label on the spectrum. 
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 Edit Label Edit label on the spectrum. 

 
 

Properties 

 

Display Interval, Change a chart (background & 

axis) color, legend display, grid, X-axis and Y-axis 

scale, and decimal point format, etc. 

See XI. Display Function Tools for more details. 

 
 

I-3-6. Result window 
 

Display result values of performed measurements. 

 

I-3-7. Trace bar 
 

Display X-axis and Y-axis values of the mouse pointer on the spectrum. 

 
 

I-3-8. Monitoring Bar 
 

Display the current wavelength and photometric value. 

Common functions for measurement. 

 

Icon Command 

 
Displays the current photometric value 

 
Displays the current wavelength 

 

Set the absorbance value(or transmittance) of the current

wavelength to Zero (100%T for transmittance) 

 
Measures data for baseline correction 

 
Measures data for blank correction 

 
Collects a sample spectrum 

 
Stops measuring data 
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I-3-9. Data/Method List 
 

Search and select the saved Data and Method in folder trees. 

 

 

I-3-10. Spectrum List 
 

Check the spectrum that displayed on the Main Window. 
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II. File Menu 
 

The File menu includes commands to perform general file functions as shown in the following 

table. 

 

 
 

 

 

 
 

 

II-1. New  
 

 Use the New command to open a new window. 

 Procedure 

1. Click New to open a new window.  
  

 

 
2. Enter a Title and Comment (if desired) and select the Experiment Type. If you do not 

enter a title, the title will be assigned automatically as [Untitled-1], [Untitled-2]..... 

 

3. Click OK. 

Command Function 

New 

Open 

Close 

Close All 

Open a new window 

Open saved data 

Close the current window 

Close all windows 

Save 

Save As 

Save data  

Save data using a new file name 

Open Method 

Save Method 

Open a saved method 

Save a method  

Export Export data to another program 

Print Print results  

Exit Exit UV Express Software 
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II-2. Open  
 

 Use the Open command to open data in a file. 

 Procedure 

1. Select a file to open, the title, date, comment, experiment type and spectrum is displayed. 

 

2. Select Open. 

 

3. To open several sets of data in the same window, hold down either the Shift or Control 

key, select the files, and click OK. 

 

4. The selected files can be displayed in a new window by clicking Open in New Window at 

the bottom of the box. 
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The following file type options are available: 

File Type Description 

UV Express General Files (*.dgdt) Scan Setup data  

UV Express Quantification Files (*.dqdt) Quantification data 

UV Express Kinetics Files (*.dkdt) Kinetics data 

UV Express Wavelength Program Files (*.dsrdt) Wavelength Program data 

UV Express Scanning Kinetics Files (*.dskdt) Scanning Kinetics data 

UV Express Scanning Quantification Files (*.dsqdt) Scanning Quantification data 

UV Express Nucleic acid Files (*.dbdt) Nucleic Acid data 

UV Express Protein Analysis Files (*.dpdt) Protein Analysis data 

UV Express Cell Density Files (*.dcdt) Cell Density data 

UV Express Thermal Denaturation Files (*.dthdt) Thermal Denaturation data 

UV Express Validation Files (*.dvdt) Validation data 

UV Express Multi-Component Analysis Files 
(*.dmcdt) 

Multi-Component Analysis data 

Spectra (*.sp) UV WinLab data 

 
II-3. Close 

 
 Use the Close command to close a window. 

 Verify the data was saved before closing the window. 

 
 

II-4. Close All 
 

 Use the Close All command to close all windows. 

 
 

II-5. Save 
 

 Use the Save command to save the data in the current window. 

 Procedure 
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1. To save data, select a folder to save data in, enter a file name, and click Save. 

 

Please refer to II-2. Open for file types. 

 

II-6. Save As 
 

 Use the Save As command to save data using a new file name. 

 Procedure 

1. To save data with a new file name, select a folder to save the file in, enter a file name and 

click Save. 

 

Refer to II-2. Open for file types. 
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II-7. Open Method 
 

 Use the Open Method command to open a method stored in a file. 

 Procedure  

1. To open a method, select a file to open and click Open. The method file extension is 

“.gmtd”. 

 

II-8. Save method 

 
 Use the Save Method command to save the current setting for the data collection and 

processing methods. 

 Procedure 

1. To save a method, enter a file name and click Save. 

  

2. Method file extensions are automatically assigned as *.gmtd. 
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II-9. Export 
 

 Use the Export command to export the data to another program such as Microsoft Excel, 

or other Windows programs. 

 Procedure 

1. Click Export. Choose the desired format type as shown below, and click OK. 

  

 

File Type Description 

Export Sample Spectrum  

Clipboard(Copy) Copy the spectrum as the picture. 
 

CSV Format File Export a spectrum as a *.csv file. The interval 

between wavelengths is determined by the 

sampling interval. 

ASCII Format File Export a spectrum as a *.asc file. 

JCAMP Format File Export a spectrum as a *.dx file. 

Bitmap(BMP) Format File Export a spectrum as *. bmp file. 

Window Meta File(WMF) Format File Export a spectrum as *.wmf file. 
 

Export Result Data  

Clipboard(Copy) Copy the result data 

Microsoft Excel Format File Export the result data as MS Excel format file 
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II-10. Print   
 

 Use the Print command to print or preview data in the current window. 

 Procedure 

1. The following print-preview window will be displayed. 

 

2. Select the required print contents and select Print. 

  

 

Function Description 

Pre Page 

Next Page 

Zoon In 

Zoom Out 

 

Pre Page allows you to go back to the previous page 

Next Page allows you to go to the next page 

Zoom In allow you to maximize the window 

Zoom Out allows you to revert the maximized the window to 

the standard size 
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NOTE: User can change the company logo. 

a. Click Open Logo. 

 

b. Select the desired company logo. The selectable logo file is *.bmp file and the 

recommended size is 110x50 pixels. 

c. Confirm the company logo is changed. 

 

II-11. Exit 
 

 Use the Exit command to close UV Express Software. 
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III. Edit Menu 
 

The Edit menu includes commands to perform spectrum functions as shown in the following 

table. 

 

 
 

Command Function 

Undo Undo previous 

Cut Spectrum Cut spectrum  

Copy Spectrum Copies spectrum 

Paste Spectrum Pastes the copied/cut spectrum 

Delete Spectrum Deletes selected spectrum 

Delete All Delete all selected spectra in a Window 

Select All Select all spectra in a Window 

 

III-1. Undo             
 

 Use the Undo command to undo a previous edit operation. 

 Procedure 

1. To undo an edit, click Undo in the Edit menu. 
 

 

III-2. Cut     
 

 Use the Cut command to remove the selected spectra and place the cut items on the 

clipboard.  

 Procedure 

1. Select a spectrum to cut. 
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2. Select Cut in the Edit menu. If there are several spectra in the window, select Spectrum 

List to choose a particular spectrum to cut. 
 

3. Place the cut spectrum in another location using the Paste command. 

 

III-3. Copy 
 

 Use the Copy command to duplicate the selected items onto the clipboard.  

 Procedure 

1. Select a spectrum to copy and click Copy in the Edit menu. 

 
2. Paste the copy into another location using the Paste command. 

 

III-4. Paste 
 

 Use the Paste command to place a cut or copied item in the desired location. 

 Procedure 

1. Cut or copy a spectrum to paste into a window. 

 

2. Select Paste in the selected window. Copies of the same item can continue to be pasted 

until another item is cut or copied.  

 

III-5. Delete 
 

 Use the Delete command to delete the selected spectrum from the active spectrum 

window. 

 Procedure 

1. Select a spectrum to delete or click Select All to delete all spectra in the window. 

 
2. Click Delete. 

 

III-6. Select All 
 

 Use the Select All command to select all spectra in the active spectral window. 

 Procedure 

1. To select all, select Select All.  
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IV. View Menu 

 The View menu includes commands to change and customize software windows as show 

below. 

    
     

Command Function 

Menu Bar 
Create the icons of Scan Setup, Equation Calculation, Find 

Peak/Valley 

Absorbance Display the unit of Y-axis by absorbance 

Transmittance Display the unit of Y-axis by transmittance 

Reflectance Display the unit of Y-axis by reflectance 

Energy Display the unit of Y-axis by energy 

Experiment Information Display Experiment Information 

User Information Display User Information 

 
 

IV-1. Absorbance 
 

 Use the Absorbance command to convert the unit of the Y-axis to absorbance mode. 

 Procedure 

1. Click Absorbance, and the unit of the Y-axis changes to absorbance mode. 

  

IV-2. Transmittance 
 

 Use the Transmittance command to convert the unit of the Y-axis to transmittance mode. 

 Procedure 

1. Select Transmittance and the unit of the Y-axis changes to transmittance mode. 
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IV-3. Reflectance  
 

 Use the Reflectance command to convert the unit of the Y-axis to reflectance mode. 

 Procedure 

1. Select Reflectance and the unit of the Y-axis changes to reflectance mode. 

 

IV-4. Energy 
 

 Use the Intensity command to convert the unit of the Y-axis to intensity mode. 

 Procedure 

1. Select Energy and the unit of the Y-axis changes to energy mode. 

 

IV-5. Experimental Information 
 

 Use the Experiment Information command to exchange the experiment information. 

 Procedure 

1. Click Experiment Information.  

 
2. Enter Title, System Name and Comment information. A comment can include up to 80 

characters. Select OK.  

 
 

3. User can check the information at the Experiment Information contents of print window. 

 

 

IV-6. User Information 
 

 Use the User Information command to exchange the user information. 

 Procedure 
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1. Click User Information. Enter Name information and select OK. 

 

 
2. User can check the information at the User Information contents of print window. 
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V. Measure Menu 

The Measure menu includes commands to perform measurement as shown in the following 

table. 

 

 

Command Function 

Zero 
Sets the absorbance value (or transmittance) of the current 

wavelength to zero (100%T for transmittance) 

Baseline Measure data for baseline correction  

Blank Collect a blank spectrum in case of single beam type 

Sample  Collect a sample spectrum 

Stop Stop measuring 

Go to Wavelength Move the grating to the desired wavelength 

Align Move the grating when the accessory is used 

Options Select one of save methods and Baseline Display method 

Lamps & Electrics Check the lamp status 
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V-1. Zero 
 

 Use the Zero command to set the absorbance (or transmittance) of the current wavelength 

to zero (100%T for transmittance). 

 Procedure 

1. Select Zero. 

 
2. Change the absorbance of the current wavelength to zero. 

 

V-2. Baseline 
 

 Measure data to collect the 100%T baseline scan. 

 Procedure 

1. Select Baseline. 

 
2. Insert blank solutions into the reference and sample holders or empty the cell holders. 

Select OK. 

 

 

V-3. Blank 
 

 Use the Blank command to collect a new blank spectrum in the single beam type. 

 Procedure 

1. Place a blank in the sample holder. 

 
2. Select Blank. 

Measure a new blank spectrum each time parameters for an experiment are changed. 

  

V-4. Sample 
 

 Use the Sample command to measure a sample. 

 Procedure 

1. Place a sample in the sample holder and a reference in the reference holder. 
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2. Select Sample. 

This icon is activated after a Baseline is measured. 

 

V-5. Stop 
 

 Use the Stop command to stop data collection. 

 Procedure 

1. Select Stop. 

 
2. Stop measuring. 

 

V-6. Go to Wavelength 
 

 Move to the grating when the desired wavelength. 

 Procedure 

1. Select Go to Wavelength. 

 
2. Set the desired wavelength and click OK. 

 

 This is intended for service. Please uncheck the Zero Order. 

 

V-7. Align 
 

 Move to the grating when the accessory is used. 

 Procedure 

1. Click Align. 

 
2. Move to the grating to the 0 nm. 

 

V-8. Options 
 
 Select one of save methods and Baseline Display methods. 
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V-8-1. File Save Method 
 

 Save the method automatically or manually. 

 Procedure  

1. Select Options and File Save Method tab. 

 
2. Select one of save methods. Select OK.  

 

a. Save Off : User can save the desired data.  

 
b. Save On (prompt at start): Display the windows Save As dialog box at the start of the 

collect where user can enter the file name for data. 

  
c. Save On (prompt at end): Display the windows Save As dialog box at the end of the 

collect where user can enter the file name for data. 

 

 

V-8-2. Baseline Display 
 

 Display Baseline scan data after measure sample. 
 Procedure  

1. Select Options and Baseline Display tab. 

 
2. Select Yes or No. Click OK.  
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V-9. Lamps & Electrics 

 
 Check the lamp status. 

 Procedure 

1. Select Lamps & Electrics.  

 

2. Check the lamp status. 

 

a. Lamp Status: Use to verify the ON/OFF status of the lamps. When lamp is turned on, 

the circle appears yellow. When it is turned off the circle appears white. 

 
b. Lamp Control: Use to control ON/OFF status of the lamps. The user must wait until the 

process of updating the status is completed and disappears. 

 
c. Lamp Monitoring:  

Lamp Time: View the exhausted time of lamp. Select Clear to reset the time count only 

when installing a new lamp. 

 
d. Power Monitoring: Use to check the power status. 
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V-9-1. Lamp Status 
 

Use to check the ON/OFF status of lamps. When lamp is turned on, the circle appears 

yellow. When it is turned off the circle appears white. 

 
Example 1: Both lamps are turned on. 

 
 

Example 2: Only the VIS (tungsten) lamp is turned on.  

 
 

V-9-2. Lamp Control 
 

Use to control the ON/OFF status of the lamps. 

 
1. Select On in the Deuterium Lamp Control to turn on the Deuterium (UV)lamp. The user 

must wait until the process of updating the status is completed and disappears. 

 

2. Select OFF in the Deuterium Lamp Control to turn it off. 

 

 
3. Select ON in the Tungsten Lamp Control to turn on the Tungsten (VIS) lamp. 

 
4. Select OFF in Tungsten Lamp Control to turn it off. 
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V-9-3. Lamp Monitoring 
 

Use to check the lamp power and time used. 

 
1. Lamp Time: View the exhausted time of lamp. Click Clear to reset the time count only 

when installing a new lamp. 
 

  

Lamp Life Time: 

 . Deuterium lamp: 2,000 hours 

 . Tungsten lamp:  1,500 hours: 

 

V-9-4. Power Monitoring 
 

View status for the power of the instrument. 
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VI. Method Menu 
 

 Setup parameters for the measurement. 

 Refer to each mode in details. 

 

VII. Math Menu 
 

 
The Math menu includes commands to analyze the collected data. 

 

  
 

Command Function 

Area Perform to calculate the area 

Smoothing Smooth the spectrum 

Derivative Obtain data after applying a derivative 

Scalar Add   Add a constant value to y-value  

Scalar Multiply   Multiply the y-value by a constant value 

Scalar Divide   Divide the y-value by a constant value 

Log Compute the common logarithm of the y-value 

Add Obtain added data of two spectra 

Subtract Obtain subtracted data of two spectra 

Average Obtain the average data of spectra 
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VII-1. Area 
 Use the Area command to calculate the are in the specified range 

 Procedure 

1. Select Area. The following dialog box is displayed. 

 

2. Set the parameters. 

a. Exclude Baseline: Exclude the baseline from the calculated area value automatically. 

b. View Area Value: Display the area value in the result window. 

c. Start Wave (nm): Enter the start wavelength for the area calculation. 

d. End Wave (nm): Enter the end wavelength for the area calculation. 

e. Area: Display the calculated value.  

3. After entering the parameters, click the Area icon.  

4. The calculated area and range are displayed in the Area tab. If you check View Area value, 

the area and range are displayed in the result window. 
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VII-2. Smoothing 

 
 Use the Smoothing command to smooth the spectrum. 

 Procedure 

1. Select Smoothing. The following dialog box is displayed. 

 

 
2. Set the function parameters. 

a. Smoothing: Select Yes or No. 

b. Window Size: Select the data point to use to smooth the spectrum. 
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c. Polynomial Degree: Select the dimension of curve fitting.  

d. Processing Spectrum: Select Add new spectrum or Change original spectrum. 

 
3. After setting parameters is complete, click OK. The result is displayed in the main window. 

 

NOTE: Savitsky-Golay Smoothing 

UV Express uses the Savitsky-Golay method for the data smoothing. Using the 

Savitsky-Golay method results in the elimination of (window size)/2 points on each end of 

the smoothed value in the middle of the window. It is the preferred method for noise 

reduction and is also recommended for smoothing because no truncation of the data 

occurs. 

 

VII-3. Derivative 
 

 Use the Derivative command to obtain the derivative data of the spectrum. 

 Procedure 

1. Select Derivative. The following dialog box will be displayed. 

  

 
2. Select OK after entering the Derivative Order number and selecting the Processing 

Spectrum. The result will be displayed in the main window. 

 

VII-4. Scalar Add 
 

 Use the Scalar Add command to add a value to the Y-axis of a spectrum 

 Procedure 

1. Select Scalar Add. The following dialog box will be displayed. 

  

 
2. Enter the value to add to the spectrum. 
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3. Select Add new spectrum or Change original spectrum. 

 
4. Click OK. The result will be displayed in the main window. 

 

VII-5. Scalar Multiply 
 

 Use the Scalar Multiply command to multiply the Y-axis of a spectrum by a value 

 Procedure 

1. Select Scalar Multiply. The following dialog box will be displayed. 

  

 
2. Enter the value to multiply the spectrum. 

 
3. Select Add new spectrum or Change original spectrum. 

 
4. Select OK. The result will be displayed in the main window. 

 

VII-6. Scalar Divide 

 
 Use the Scalar Divide command to divide the Y-axis of a spectrum by a value 

 Procedure 

1. Select Scalar Divide. The following dialog box will be displayed. 

  
 

2. Enter the value to divide the spectrum. 

 
3. Select Add new spectrum or Change original spectrum. 

 
4. Select OK. The result is displayed in the main window.  
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VII-7. Log 

 
 Use the Log command to compute the log of a spectrum. 

 Procedure 

1. Select Log. The following dialog box will be displayed. 

  

 
2. Select Add new spectrum or Change original spectrum. 

 
3. Click OK. The result is displayed in the main window. 

 

VII-8. Add 

 
 Use the Add command to add the Y-axis values of selected spectra. 

 Procedure 

1. Select desired spectra to add by clicking the spectra while holding down the Ctrl key.  

 
2. Select OK. The result is displayed in the main window. 

 

VII-9. Subtract 

 
 Use the Subtract command to subtract the Y-axis values of two spectra. 

 Procedure 

1. Select two spectra to subtract by clicking the spectra while holding down the Ctrl key. The 

following dialog box is displayed. 

 

 
2. Select the appropriate equation. 

 
3. Select OK. The subtracted result is displayed in the main window. 
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VII-10. Average 

 
 Use the Average command to calculate the average of selected spectra. 

 Procedure 

1. Select the spectra to average together by clicking the spectra while holding down the Ctrl 

key or using the Select All command. 

 

2. Select OK. The average result is displayed in the main window. 
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VIII. Window Menu 
 

 

 

The Window Menu to arrange the windows and show the current windows. 

 
 

Command Functions 

Tile Horizontally Display Windows in horizontal the mode 

Tile Vertically Display Windows in vertical tile mode 

Cascade Display Windows in cascade mode 

 
 

VIII-1. Tile Horizontally 
 

Use the Tile Horizontally commands to align the windows in the horizontal tile modes as 
below. 
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VIII-2. Tile Vertically 
 

Use the Tile Vertically commands to align the windows in the vertical tile mode as below. 

 
 

VIII-3. Cascade 
 

Use the Cascade commands to align the windows in the cascade mode as below. 

 

 

 The titles of the current windows are displayed as below. 

 

 Procedure 

1. To view a different window, click the window you want to view and the selected window is 

displayed.  

 
2. When the data in the window is saved, the file titles are listed. 



 
 

38  UV Express Software User Guide                                         PerkinElmer 

IX. Help Menu 
 

 

The Help Menu contains the Help contents for UV Express software. 

 

 

 

    

 
 

 

 

 

IX-1. Contents 
 

Contents links to external document of the UV Express Software Users Guide. In the 

Multi-Component Analysis mode, Contents links to Multi-Component Analysis Software 

Guide. 

  

IX-2. About 
 

About UV Express contains information on the version of the software as shown below. 

 

Command Function 

Contents 

Open the UV Express Software Users Guide 

(Multi-Component Analysis Software Guide, in case 

of Multi-Component Analysis software is used) 

About... Display the version of UV Express Software 
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X. Measurement Modes 
 

X-1. SCAN Mode 
 

 This mode includes the following Experiment types: 

• Scan Setup 

• Equation Calculation 

• Find Peak/valley  

 This SCAN mode is used to obtain the desired wavelength photometric values such as 

AU, %T and %R. 

 Results in this mode are interchangeable. For example, data measured using Equation 

Calculation method can be opened in a Scan Setup method. 

 Perform a General Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Collect the baseline. 

4. Measure samples. 

5. Save or print results as required.  

 

X-1-1. Scan Setup 
 

 Use Scan Setup to collect data over the full spectral range of the instrument, or a specified 

interval. Perform this type of experiment.  

 Procedure 

1. Execute the Scan . 

 

2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 

 



 
 

40  UV Express Software User Guide                                         PerkinElmer 

3. Select Method. 

 

 
4. Setup the experiment parameters as follows: 

 

4.1 Experiment 

 

Command Function 

X Start (nm)  Input the start measurement wavelength (190 to 1100 nm) 

X End (nm) Inputs the end measurement wavelength      

Y Unit 
Displays Y-axis unit: Absorbance (AU), Transmittance (%T), 
Reflectance (%R) or Energy 

0%T / Blocked Beam 

Baseline 
Check the 0%T/Blocked Beam Baseline checkbox when 
measuring samples with high absorbance/low transmittance.

SBW 
Select Spectral Band Width: 0.5, 1, 2, 5, 20 nm. Default is 
1.0 nm. 

Spectra No. 
Parameter determines how many times the sample is tested
(1 to 999) 

Data Interval (nm) 
Select Data Interval: 0.05, 0.1, 0.5, 1.0, 2.0 nm. Default is 1.0
nm. 

Scan Rate (nm/min) Shows the scan speed per time 
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 4.2 Lamp 

 

 
 

 Command Function 

 Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type 

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position as
a double beam type 

 Lamp 

Select Lamp. 

Light Change Wavelength (nm) will be deactivated if UV or Vis 
lamp is selected. 

 
Light Change 

Wavelength (nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp. 
Enter a wavelength. (360~450 nm, default setting: 400 nm) 
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4.3 Internal Reference 

Internal Reference is a technique that can be used to improve the precision of results by 

minimizing the effects of any changes that cause a linear baseline shift, for example a drift 

in lamp intensity. This technique is particularly useful for samples with low absorbance.  

 

 

 

Command Function 

Use Select using Internal Reference as Yes or No. 

Type 

 

Select Internal Reference type. 

There are three methods of calculating the baseline values. The value 

is calculated by method suited to each condition. 

 
 

Single Point:  

Single point method is used when the baseline shift is the same at all 

wavelengths. The reference wavelength is usually selected at a point 

on the baseline. Baseline value is eliminated by subtracting the 

absorbance at reference wavelength from the absorbance of full 

wavelength. 
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fλ = Aλ - ARλfλ = Aλ - ARλ
 

 
fλ is the function result at wavelength λ 

Aλ is the absorbance at wavelength λ 

ARλ is the absorbance at reference wavelength λR 

 
Range Average:  

The range average method is as an extension of the single point 

method, is used when it is hard to select reference wavelength as a 

point. In this method, reference wavelength replaces the single  

wavelength absorbance value with the average absorbance value  

over a wavelength range. 
 

 

Three Points:  

Three points method is used correction of slant baseline, then the  

absorbance values from the two reference wavelengths, AR1 and AR2, 

define a straight line which is used to calculate the reference  

absorbance (ARλ) at the wavelength(λ). Result spectrum calculated by 

following equation. 

 

Aλ

ARλ

0

λ λR

fλ

Spectrum

Result spectrum

Aλ

ARλ

0

λ λR

fλ

Spectrum

Result spectrum
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ARλ =
λR2 – λR1

1 
｛(λR2 - λ)AR1 + (λ – λR1)AR2｝ARλ =

λR2 – λR1

1 
｛(λR2 - λ)AR1 + (λ – λR1)AR2｝ARλ =

λR2 – λR1

1 
｛(λR2 - λ)AR1 + (λ – λR1)AR2｝

fλ = Aλ - ARλfλ = Aλ - ARλ  
 
fλ is the function result at wavelength λ 

Aλ is the absorbance at wavelength λ 

ARλ is the reference absorbance at wavelength Rλ 

Wavelength 

1 (nm) 
Select the reference wavelength. 

Wavelength 

2 (nm) 

Select the reference wavelength and this would be deactivated at 

Single Point type. 

Reflectance 

correction 

Reflectance correction allows user to collect absolute reflectance data.
 

 
 

Rabsolute is absolute specular reflection (%) 

Fcorrection is the correction factor to correct the actual reflectance of 

standard mirror.  

Rmeasured is actual measured specular reflection (%) 

 

Before calculating reflectance data, user must retrieve a standard 

reference file by clicking the Import button. This file must be obtained 

from the manufacturer of the standard [The imported file should be 

formatted in .CSV]. User can also manually enter the standard value 

using the Insert or Delete buttons.  

 

1. Select Yes. 

 
2. Enter the wavelengths and correction factors. 
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3. If you have a standard reference file as CSV format, click Import 

and select the standard reference file to import rather than 

entering wavelengths and correction factors one by one.  

 

NOTE: The data in an imported standard reference file (.CSV) should 

be formatted as shown in the picture below: 

wavelength-semicolon-factor. 

 
 

4. Click Apply and then OK. The corrected spectrum and results are 

shown in the main result window. 

 
4.4 Scan Setup 
 
Enter the wavelength using Insert and Delete.  
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4.5 Accessory 

For more details of accessory setting refer to each accessory manual. 

 

5. After completing parameter setup for Experiment, Lamp, Internal Reference and Scan 

Setup, select Apply and then click OK. 

 
6. Depending on the samples, empty the cell holder or input the blank into Reference and 

Sample holder both. Close the sample compartment cover and measure Baseline using 

Baseline  icon. 

 
NOTE: The baseline defines the absorbance 0 (or transmittance 100%) and is subtracted from the 

measurement result to give a correct sample spectrum (or is divided in the case of 

transmittance) 

 
NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

  
NOTE: You should measure Baseline whenever the wavelength is changed or SBW is changed or 

Reference sample is changed. 

 
7. Input the sample into the sample holder and close the sample compartment cover and 

then, click Sample  icon. 
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8. Input the sample name and click OK. 

 

NOTE: After finishing the measurement, if you want to change a sample name, select the sample 

name to be changed in the Result Window and press the Enter key after changing the 

name. 

 
9. The spectrum and result will be shown. 

 
10. Save or print spectrum and results as desired. 

 
 

  

X-1-2. Equation Calculation  

 

 Use Equation Calculation to collect data for a calculated result using a specified equation. 

 Procedure 

1. Execute the Scan.  

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 

 
3. Select Method. 
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4. Setup the Experiment, Lamp and Internal Reference parameters. See X-1-1. Scan Setup 

for more details. 

4.1 Equation Calculation 

 

Command Function 

Setup 
Set up a new equation and create a new row using Insert 
or Delete 

Name Enter the equation name 

Unit 
Enter the units of the Y-axis. Absorbance, transmittance 
or reflectance 

Wavelength (nm) 
Enter the wavelength to be used in the calculation. Up to 
8 wavelengths (absorbance/transmittance value) can be 
input to the equation 

ABS Calculates the absolute value of the expression 

EXP Calculates exponential 

LN Calculates the natural logarithm of the expression 

LOG10  Calculates the common logarithm of the expression 

SQRT Calculates the square root of the expression 
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5. Enter the Name and Unit of equation.  

 

 
6. Enter the Wavelengths to make equation. User can add or remove the wavelength by 

clicking  or  button. 

 

 

7. After completing equation, click Apply to selected equation . 

NOTE: Make sure that whenever making each equation, user should always click the Apply to 

selected equation button.  

 

 
8. If you want to make another equation, add the Name and Unit of equation by clicking the 

Insert button.  

 

 
9. Repeat procedure #6~7.  
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10.  After completing parameter setup for Experiment, Lamp, Internal Reference and 

Equation Calculation, select Apply and then select OK. 

 
11. Depending on the samples, empty the cell holder or input the blank into Reference and 

Sample holder both. Close the sample compartment cover and measure Baseline using 

Baseline  icon. 

NOTE: The baseline defines the absorbance 0(or transmittance 100%) and is subtracted from the 

measurement result to give a correct sample spectrum (or is divided in the case of 

transmittance) 

 
NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

 
NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 
12. Input the sample into the sample holder and close the sample compartment cover and 

then, click Sample  icon. 
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13. Input the sample name and click OK. 

 

NOTE: When you want to change the sample name, you can select [Name] in the Result Window 

(changed as yellow color) and should click Enter after changing the name. 

 
14. The spectrum and result will be shown. 

 
15. Save or print spectrum and results as desired. 

 

X-1-3. Find Peak/Valley 
 

 Use Find Peak/Valley to determine the maxima and minima of Y-values in the defined 

wavelength range of the spectrum. 

 Procedure 

1. Execute the Scan.  

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 
 

3. Click Method. 

 

 
4. Setup the experiment, Lamp and Internal Reference parameters. See X-1-1. Scan Setup 

for more details. 

NOTE: You should enter the suitable sensitivity value and masking range to find the right peaks 

and valleys. 
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4.1 Find Peak/Valley 

 

Command Function 

Automatic Find 
YES: Finds automatically 

NO: Finds manually 

Threshold (AU) 
Enter an absorbance value for the threshold. Peaks  
about this threshold are included in the result window.  

Threshold (%T, %R) 
Enter a transmittance (or reflectance) value for the 
threshold. Peaks about this threshold are included in the 
result window. 

Threshold (E) 
Enter an intensity value for the threshold. Peaks about this 
threshold are included in the result window. 

Find Peak Select Yes or No for finding peaks. 

Peak No. 
Enter the numbers of peak to find. 
The number of peak can be selected from 1 to 39 or all of 
the peaks. 

Find Valley Select Yes or No for finding valleys. 

Valley No. 
Enter the numbers of valley to find. 
The number of valley can be selected from 1 to 39 or all of 
the valleys. 
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5. After completing parameter setup for Experiment, Lamp, Internal Reference and Find 

Peak/Valley, click Apply and then click OK. 

 
6. Depending on the samples, empty the cell holder or input the blank into Reference and 

Sample holder both. Close the sample compartment cover and measure Baseline using 

Baseline  icon. 

NOTE: The baseline defines the absorbance 0(or transmittance 100%) and is subtracted from the 

measurement result to give a correct sample spectrum (or is divided in the case of 

transmittance). 

 
NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

 
NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 

7. Input the sample into the sample holder and close the sample compartment cover and 

then, select Sample  icon. 
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8. Input the sample name and select OK. 

 

NOTE: When you want to change the sample name, you can select [Name] in the Result Window 

(changed as yellow color) and should click Enter after changing the name. 

 
9. The spectrum and result will be displayed. Peaks and valleys are found automatically.  

 
10. For manual peak/valley finding, use the following icons on Spectral Display Function Tool 

after set Automatic Find as No. 

 Pick Peak     Pick Valley 

After selecting the icon, you can check the peak/valley using the mouse-drag. 

 
11. If you want to remove the peak/valley value, select it (the color will be chanced as yellow) 

and click the right button of mouse and select the command.  

 

 
12. Save or print spectrum and results as desired. 



 

 

PerkinElmer                                         UV Express Software User Guide  55 

X-2. Quantification Mode 

 

 
 Quantification Mode measures the unknown samples’ concentration based on the obtained 

standards calibration curve. 

 Use Quantification mode to quantify a sample at a single wavelength using a reference 

standard. 

 Perform a Quantification Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure standards. Create the calibration curve using a set of standards. 

5. Measure samples. 

6. Save or print results as required.  

 

 Procedure 

1. Execute the Quantification .  

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, click OK. 

 

 
3. Select Method. 

 

 

4. Setup the Experiment, Lamp and Quantification parameters.  
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4.1 Experiment 

 

Command Function 

Y Unit Displays Y-axis unit: Absorbance (AU), Transmittance (%T), 
Reflectance (%R) or Energy 

SBW 

Select Spectral Band Width (Default: 1.0) 

 

Replicates 
Select the number of replicate readings to be taken for each 

sample (1~5). The measurement is automatically repeated as set 
number. 

Sample/Std 

Average 

Select the number of reading to be taken from different solutions 
of sample/standards (1~3). 
Sample/Std has to be replaced between each count.  
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type 

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 

Select Lamp    

               
Light Change Wavelength(nm) will be deactivated if UV or VIS 

lamp is selected 

Light Change 

Wavelength 

(nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength (360 ~ 450 nm, default setting: 400 nm ) 
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4.3 Quantification 

  

Command Function 

Setup Enter each standard concentration using Insert and Delete.

Analytical Name Enter the file name 

Concentration Unit Enter the unit of concentration 

Use Wavelength (nm) Enter the wavelength to test 

Intercept No: Calibration curve passes through the origin 
Yes: Calibration curve does not pass through the origin  

Fit Order Choose the calibration curve dimension Linear, Quadratic 
or Cubic 

Limit Warning 

Message 

When the sample measurement value is out of the 
calibration curve range, the warning message will be 
shown. It can be selected as an option. 

 

4.4 Accessory 

For more details of accessory setting refer to each accessory manual. 

 

5. After completing parameter setup for Experiment, Lamp and Quantification, select Apply 

and then select OK. 

NOTE: You can save the method and open the method whenever you need. 

ex) Save [File] → [Save Method] and Open [File] → [Open Method] 
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6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU. 

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

7. Input the Standard sample into the Sample holder and then, select the Standard . 

 
8. Measure Standard samples in order and the calibration curve will be created as follow. 

 

NOTE: You can save the standard calibration curve and open the curve whenever you need. 

 

9. Input Blank and Unknown sample into each Reference and Sample holder and then, click 

Sample  icon. 

NOTE: Click Sample after measuring [Baseline] when you opened the standard curve saved. 

 
10. Input sample name and select OK. 
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11. Data will be shown as follows. 

 

a. Name: Shows the entered Standard or Sample name. 

b. Type: Displays the Standard or Sample. 

c. Concentration: Display the calculated concentration. 

d. AU: Displays the measured Y-axis value. 

e. Dilution factor: The dilution factor is set 1.0 as a default and it can be edited after the 
sample measurement. Double-click on the Dilution Factor to be changed in each 
sample measurement result and enter a new Dilution Factor and click OK. 

  

f. Original Conc.: Shows the original concentration of sample.  

(Original Concentration = Concentration x Dilution Factor) 

g. SD, %RSD: Shows the statistics of the repeated measures data.   
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NOTE: In case of checking on Limit warning Message in the Quantification tab of the Method 
window, the following message is shown as the sample measurement values is out of the 
calibration curve range. 

 
 

12. Save or print spectrum and results as desired. 
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X-3. Kinetics Mode 

 
 Use Kinetics to test reaction rate. Kinetics mode measures the changes to a sample’s 

absorbance, transmittance and reflectance over time at a fixed wavelength. 

 Perform a Kinetics Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure samples. 

5. Save or print results as required.  

 Procedure 

1. Execute the Kinetics .  

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 

 
3. Select Method. 
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4. Setup the experiment, Lamp and Kinetics parameters.  

 

4.1 Experiment 

 

Command Function 

Wavelength (nm) Enter a specific wavelength.  

Y Unit 

Displays Y-axis unit 

Absorbance: (AU) 

Transmittance: (%T) 

Reflectance: (%R) 

Energy 

SBW (nm) 

Select Spectral Band Width (Default: 1.0 nm) 
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type. 

Single Front: Only uses Sample holder as a single beam type

Single Rear: Only uses Reference holder as a single beam 
type 

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position
as a double beam type 

Lamp 

Select Lamp: UV+Vis, UV or VIS  

Light Change Wavelength (nm) will be deactivated if UV or 

VIS lamp is selected. 

Light Change 

Wavelength (nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength. (360 ~ 450 nm, default setting: 400 nm)

 



 

 

PerkinElmer                                         UV Express Software User Guide  65 

4.3 Kinetics 

 

Command Function 

Time Unit Choose a time unit either sec or min.                        

Total Run Time Enter the total running time for testing samples. 

Initial Delay Time 
You can give a delay time before the real sample measurement. 
Ex) There is no stand-by time if you enter 0 for the initial delay
time. 

Interval Time Enter the interval time between measurements. 

Response Time 

Select Response Time: 0, 0.1, 0.2, 0.5, 1, 2.5 or 10. It is the 
scanning time that stayed at a wavelength. 
Zero is the fastest scanning time that remained at a wavelength 
as short as possible.   

Rate Calculation 
Type 

Select Calculation Type 

 

▶ Zero Order 

The zero order calculation uses a linear fit to calculate the 
rate, k, b linear regression using the equation:  
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At = A0 + kt 

At is the absorbance at time t 
A0 is the absorbance at the start of the calculation time range
k is the zero order rate constant [Units: 1/ AU∙s]  

 

▶ Initial Rate 

The initial rate calculation uses a quadratic fit to calculate the 
rate, k, by linear regression using the equation:  

At = A0 + kt + t2 

 

At is the absorbance at time t 
A0 is the initial absorbance 

    k is the initial rate [Units: AU/s] 

 

First order 

The first order calculation uses an exponential fit to calculate 
the rate, k, using: 

At = A∞+ (Ao-A∞) e
-kt

 
This rate law can be rearranged to 
ln(At A∞)= ln(Ao-A∞)  kt 

 
At is the absorbance at time t 
A0 is the initial absorbance 
k is the first order rate constant [Unit: 1/s] 

 

▶Delta AU 

Delta AU is the difference between the absorbance at the 
start of the calculation time range and the absorbance at the 
end. The calculation is very simple: 

Delta AU = At - A0 
 

At is the absorbance at time t 
A0 is the initial absorbance 
Delta AU [Units: AU] 

Rate Calculation 

Start Time 
Input the start time for Kinetic Rate calculation. 

Rate Calculation 

End Time 
Input the end time for Kinetic Rate calculation. 
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NOTE: User can change the rate calculation range roughly by dragging the mouse. Select Cursor 

 icon in Spectral Display Function Tool to set the range. 

 

 
4.4 Accessory 

For more details of accessory setting refer to each accessory manual. 

 
5. After completing parameter setup for Experiment, Lamp and Kinetics, select Apply and 

then select OK. 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU.  

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed 

7. Input sample solution into the sample holder and then select Sample  icon. 

 
8. Input sample name and select OK. 

 

 

9. If you want to stop for a while on the way of measurement, select Pause  icon. 

Resume by selecting Restart  icon. 
  

10. After the experiment is completed, confirm the result data. 

 
11. Save or print spectrum and results as desired. 
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X-4. Wavelength Program Mode 
 

 Wavelength Program Mode measures the absorbance, Transmittance and reflectance at 

selected wavelengths. 

 Perform a Wavelength Program Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure samples. 

5. Save or print results as required.  

 Procedure 

1. Execute the Wavelength Program . 

 

2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 
 

3. Select Method. 

  

 
4. Setup the Experiment Setup and Lamp parameters.  
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4.1 Experiment Setup 

  

Command Function 

Wavelength (nm) Enter a specific wavelength 

Y Unit 

Displays Y-axis unit 
Absorbance: (AU) 
Transmittance: (%T) 
Reflectance: (%R) 
Energy 

SBW 

Select Spectral Band Width (Default: 1.0) 

 

Measurement No. Enter the number of repeated sample measurement. 

0%T / Blocked 

Beam Baseline 
Check the 0%T/Blocked Beam Baseline checkbox when 
measuring samples with high absorbance/low transmittance. 
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 

Select Lamp.  

               

Light Change Wavelength (nm) will be deactivated if UV or VIS 
lamp is selected. 

Light Change 
Wavelength (nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength. (360~450 nm, default setting: 400 nm) 

 

4.3 Accessory 

For more details of accessory setting refer to each accessory manual. 
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5. After completing parameter setup for Experiment Setup and Lamp, select Apply and then 

select OK. 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU.  

NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 
7. Input the sample into the sample holder and close the sample compartment cover and 

then, select Sample  icon. 

 
8. Input sample name and select OK. 

 

 
9. Data will be displayed in the result window. 

 
10. Save or print spectrum and results as desired. 
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X-5. Nucleic Acid Analysis Mode 
 

 Use Nucleic Acid Analysis Methods to perform ratio and concentration measurements on 

samples containing proteins and nucleic acids. 

 Perform a Nucleic Acid Method measurement as follows: 

1. Execute Nucleic Acid Analysis mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure samples. 

5. Save or print results as required.  

 Procedure 

1. Execute the Nucleic Acid Analysis . 

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 

 
3. Select Method. 

 

 
4. Setup the Experiment Setup and Lamp parameters.  
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4.1 Experiment Setup 

 

Command Function 

Wavelength (nm) Default wavelengths are 320, 280, 260, 230 nm. 

Y Unit 

Displays Y-axis unit 

Absorbance: (AU) 

Transmittance: (%T) 

Reflectance: (%R) 

Energy 

SBW 

Select Spectral Band Width (Default: 1.0) 

 

Measurement No. Enter the number of repeated sample measurement. 

0%T / Blocked 

Beam Baseline 
Check the 0%T/Blocked Beam Baseline checkbox when 
measuring samples with high absorbance/low transmittance. 
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 
Select Lamp: UV or UV+Vis 
Default of this mode is UV. 
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4.3 Nucleic Acid Analysis 

 

Command Function 

Analytical Name Enter the analytical name. 

Calculation Type 

Select the calculation type. 

 

Concentration Unit Enter the concentration unit for the samples. 

Cell Pathlength (mm) Enter the cell (beam) pathlength. 

Dilution Factor Enter the dilution factor. 

Nucleic Acid Factor 

Will be set automatically according to calculation type. 
UV Express uses factors 50, 37, 40 and 33 as default 
settings for dsDNA, ssDNA, RNA and Oligo nucleotides.  

 

4.4 Accessory 

For more details of accessory setting refer to each accessory manual. 
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◇?  Calculation Type 

The Nucleic Acid application is used for determining the concentration and purity of 

nucleic acid samples. The reading at 260 nm allows to calculate the concentration.   

 

▶ dsDNA, ssDNA, RNA, Oligo DNA 

 

   [Nucleic Acid Concentration] ug/ml = A260 x extinction coefficient x D.F 

 

• A260 is Absorbance at 260 nm. 

• Extinction coefficient :  

The generally accepted extinction coefficients for nucleic acids are: 

Coefficient Value 

dsDNA 50 ug/ml 

ssDNA 37 ug/ml 

RNA 40 ug/ml 

Oligo DNA 33 ug/ml 

   •   D.F is dilution factor. 

 

▶ Warburg-Christian 

   The Warburg-Christian assay with pre-selected parameters calculates protein and 

nucleic acid concentrations (in micrograms per ㎖) using the following equations with 

absorptivities calculated by Warburg and Christian.  

 

[Protein] = (1552 * A280) - (757.3 * A260), 

[Nucleic Acid] = (62.9 * A260) – (36.0 * A280) 

 

where, the absorbance at 260 nm and 280 nm are corrected for the baseline at 320 nm. 

 

▶ Kalb and Bernlohr 

   The Kalb and Bernlohr assay with pre-selected parameters calculates protein and 

nucleic acid concentrations (in micrograms per ㎖) using the following equations. 

 

[Protein] = (183.0 * A230) - (75.8 * A260), 

[Nucleic Acid] = (49.1 * A260) – (3.48 * A230) 

where, the absorbance at 260 nm and 230 nm are corrected for the baseline at 320 nm. 
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5. After completing parameter setup for Experiment Setup, Lamp and Nucleic Acid Analysis, 

select Apply and then select OK. 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU. 

NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 
7. Input the sample into the sample holder and close the sample compartment cover and 

then, select Sample  icon. 

 
8. Input sample name and click OK. 

 

 
9. Data will be displayed in the result window. 

 
10. Save or print spectrum and results as desired. 
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X-6. Protein Analysis Mode 

 

 Use Protein Analysis to quantify the amount of protein in a sample. Select from 

pre-programmed frequently used methods for quantifying proteins. 

 Perform a Protein Analysis Method measurement as follows: 

1. Execute Protein Analysis mode. 

2. Select the protein method. 

3. Set method parameters. 

4. Measure Baseline. 

5. Measure samples. 

6. Save or print results as required.  

 Procedure 

1. Execute the Protein Analysis . 

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 

 
3. Select the protein method and select Open. 

 

 



 

 

PerkinElmer                                         UV Express Software User Guide  79 

◇?  Protein Analysis Method 

The study of many biochemical processes depends upon an accurate 
measurement of the amount of protein in solution. This has led to the development 
of several protein quantification methods, the most common of which are described 
below.  

 

Method 

Name 
Reagents 

Wavelength

[nm] 

Concentration 

Range [µg/ml] 
Method File 

Biuret 
Dilute copper sulfate in strong 
alkali 

540 200–2000 Biuret.pmtd 

Lowry 
(high 
sensitivity) 

Dilute copper sulfate in strong 
alkali and Folin-Ciocalteu 
reagent 

750 4–200 LowryHigh.pmtd

Lowry 
(low 
sensitivity) 

Dilute copper sulfate in strong 
alkali, Folin-Ciocalteu reagent

500 60–400 LowryLow.pmtd

Lowry 
(modified) 

Dilute copper sulfate in strong 
alkali and Folin-Ciocalteu 
reagent and dithiothreitol 

740 3–200 Lowry.pmtd 

Bradford 
Goomassie Brilliant Blue 
G250 in dilute acid 

595 2–50 Bradford.pmtd 

Bicinchoninic 
acid (BCA) 

Bicinchoninic acid 562 4–400 BCA.pmtd 

Trinitrobenze
ne Sulfonate 
(TNBS) 

Hydrochloric acid and 
trinitrobenzene reagent 

416 0.5–100 TNSB.pmtd 

 

1. Biuret Method 

Biuret (NH2-CO-NH-CO-NH2) produces a violet chelate compound when reacting with 
alkali CuSO4. 

 
Using the theory that a compound which has more than two peptide bonds also 
produces a chelate compound, by the same procedure as in the Biuret case, one can 
determine the protein concentration. Approximately, 1~10 mg of protein can be 
quantified by the Biuret method. Using a microassay one can measure as 0.25 mg~2.0 
mg of protein. A chelate compound is usually stable for 1~2 hours but its chromaticity 
gradually increases with time. The absorbance of the sample in the test tube is 
measured at 540 nm. 
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2. Lowry Method 

The Lowry procedure is one of the most venerable and widely used protein assays, 
being first described in 1951 [Lowry et al., J. Biol. Chem. 193: 265-275 (1951)]. Under 
alkaline conditions, copper complexes with protein. When folin phenol reagent 
(phospho-molybdic-phosphotungstic reagent) is added, the folin-phenol reagent binds 
to the protein. Bound reagent is slowly reduced and changes color from yellow to blue. 
The Lowry method is more sensitive than the Biuret method and can measure 10~200 
g of protein. The absorbance of the sample in the test tube is measured at 750 nm. 

 

3. Bradford Method  

One of the most widely used methods was developed by Bradford; it is based upon a 
shift in the absorption spectrum of Coomassie Brilliant Blue G-250 when the dye binds 
to protein in an acidic solution. The method is fast, convenient, and produces an 
equivalent absorbance change for many different proteins. The absorbance of the 
resulting solution is measured spectrophotometrically at 595 nm and compared to a 
standard curve generated using known quantities of a control protein in the dye 
solution. In this method, color reaction is completed very quickly (in 2 min.) and it is 
stable for 1 hour. The Bradford method is more sensitive than the Lowry method and 
can measure 1~20 g of protein using micro assay. The Bradford method is faster and 
is seldom affected by non-protein components. 

 

4. BCA Protein Assay 

BCA Protein Assay uses a detergent-compatible formulation based on bicinchoninic 
acid (BCA) for the colorimetric detection and quantification of total protein. This method 
combines the well-known reduction of Cu2+ to Cu+ by protein in an alkaline medium (the 
Biuret reaction) with the highly sensitive and selective colorimetric detection of the 
cuprous cation (Cu+) using a unique reagent containing BCA. The purple-colored 
reaction product in this assay is formed by the chelation of two molecules of BCA with 
one cuprous ion. This water-soluble complex exhibits a strong absorbance at 562 nm 
that is nearly linear with increasing protein concentrations over a broad working range 
(20-2,000 g/ml). The BCA method is not a true end-point method; i.e., the final color 
continues to develop. However, following incubation, the rate of continued color 
development is sufficiently slow to allow large number of samples to be assayed 
together. 

 

4. Setup the Experiment Setup and Lamp parameters.  
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4.1 Experiment Setup 

 

Command Function 

Y Unit 

Displays Y-axis unit 

Absorbance: (AU) 

Transmittance: (%T) 

Reflectance: (%R) 

Energy 

SBW 

Select Spectral Band Width (Default: 1.0) 

 

Replicates 
Select the number of replicate readings to be taken for each 

sample (1~5). 

Sample/Std 

Average 

Select the number of reading to be taken from different solutions 

of sample/standards (1~3). 
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type 

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 

Select Lamp  

               
Light Change Wavelength (nm) will be deactivated if UV or VIS 

lamp is selected. 

Light Change 

Wavelength 

(nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength. (360 ~ 450 nm, default setting: 400 nm) 
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4.3 Quantification 

 

Command Function 

Setup Enter each standard concentration using Insert and Delete.

Analytical Name Enter the file name. 

Concentration Unit Enter the unit of concentration. 

Use Wavelength (nm) Enter the wavelength to test. 

Intercept No: Calibration Curve passes through the origin 
Yes: Calibration Curve does not pass through the origin  

Fit Order Choose the calibration curve dimension Linear, Quadratic 
or Cubic. 

Limit Warning 

Message 

When the sample measurement value is out of the 
calibration curve range, the warning message will be 
shown. It can be selected as an option. 

 

4.4 Accessory 

For more details of accessory setting refer to each accessory manual. 
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5. After completing parameter setup for Experiment Setup, Lamp and Quantification, select 

Apply and then select OK. 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU. 

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

7. Input the standard solution into the Sample holder and then click Standard  icon. 

 
8. Input standard name and select OK. 

 

 
9. Measure Standard samples in order and the calibration curve will be created as follows. 

 

NOTE: You can save the standard calibration curve and open the curve whenever you need. 
 

10. Input Blank and Unknown sample into each Reference and Sample holder and then, 

select Sample  icon. 
NOTE: Click Sample after measuring [Baseline] when you opened the standard curve saved. 
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11. Input sample name and select OK. 

 

 
12. Data will be shown as follows. 

 

a. Name: Shows the entered Standard or Sample name. 

b. Type: Displays the Standard or Sample. 

c. Concentration: Display the calculated concentration. 

d. AU: Displays the measured Y-axis value. 

e. Dilution factor: The dilution factor is set 1.0 as a default and it can be edited after the 
sample measurement. Double-click on the Dilution Factor to be changed in each 
sample measurement result and enter a new Dilution Factor and click OK. 

  

f. Original Conc.: Shows the original concentration of sample.  

(Original Concentration = Concentration x Dilution Factor) 

g. SD, %RSD: Shows the statistics of the repeated measures data.    
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NOTE: In case of checking on Limit warning Message in the Quantification tab of the Method 
window, the following message is shown as the sample measurement values is out of the 
calibration curve range. 

 

 

13. Save or print spectrum and results as desired.  
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X-7. Cell Density Mode 

 

 Use Cell Density to determinate the absorbance at 600 nm.  

 Perform a Cell Density Method measurement as follows: 

1. Execute Cell Density mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure samples. 

5. Save or print results as required.  

 Procedure 

1. Execute the Cell Density .  

 
2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, select OK. 

 

 
3. Select Method. 

 

 
4. Setup the Experiment Setup and Lamp parameters.  
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4.1 Experiment  

 

Command Function 

Wavelength (nm) Default wavelengths are 600 nm. 

Y Unit 

Displays Y-axis unit. 

Absorbance: (AU) 

Transmittance: (%T) 

Reflectance: (%R) 

Energy 

SBW 

Select Spectral Band Width (Default: 1.0). 

 

Measurement No. Enter the number of repeated sample measurement. 
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 

Select Lamp: UV + VIS, UV or VIS 

Light Change Wavelength (nm) will be deactivated if UV or VIS 
lamp is selected. 

Light Change 

Wavelength (nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength. (360~450 nm, default setting: 400 nm) 
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4.3 Cell Density 

 

Command Function 

Analytical Name Enter the analytical name. 

Factor Set a desired factor value. [used when entering cell/ml in Units] 

Multiplier 

Set a desired Multiplier value.  
[used when entering cells/ml in Units] 
 
When entering OD in Units, set the Factor and Multiplier as 1. 
 
Factor and Multiplier define the conversion of the measured OD to 
the number of cells per milliliter (e.g.: Factor 5, Multiplier:  
100,000,000) 
1 OD 600 = 5 x 108 cells/ml 

Units Enter OD or cells/ml.  

 

4.4 Accessory 

For more details of accessory setting refer to each accessory manual. 

 

5. After completing parameter setup for Experiment, Lamp and Cell Density, click Apply and 

then click OK. 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU. 
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NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 
7. Input the sample into the sample holder and close the sample compartment cover and 

then, select Sample  icon. 

 
8. Input sample name and click OK. 

 

 
9. Data will be displayed in the result window. 

 
10. Save or print spectrum and results as desired. 
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X-8. Thermal Denaturation Mode 

 

 Use Thermal Denaturation mode to collect the temperature based data and perform a classical 

DNA melting experiment. 

 Perform a Thermal Denaturation Method measurement as follows: 

1. Execute Thermal Denaturation mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure samples. 

5. Save or print results as required.  

 Procedure 

1. Execute the Thermal Denaturation .  

 

2. The following window will be displayed. Enter Title, Comment and select Experiment 

Type and then, select OK. 

 

 
3. Select Method. 
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4. Setup the Experiment, Lamp and Accessory parameters.  

 

4.1 Experiment  

  

Command Function 

Wavelength (nm) 

Enter the wavelength using Insert and Delete. 
If the 6-Position Peltier Controlled Cell Changer is used, the 
number of wavelength should be the same as the number of 
Using Cell and the Wavelength Range number will coincide with 
the cell position order in the Using Cells in the Multi-Cell Holder 
Setup window. 

Y Unit 
Displays Y-axis unit: Absorbance (AU), Transmittance: (%T) 

Reflectance: (%R) or Energy 

SBW 
Select Spectral Band Width: 0.5, 1.0, 2.0, 5.0, and 20.0 nm.
Default is 1.0 nm 

Tm_Method 
Select a method for determining Tm (DNA melting temperature). 
Options include: 1st derivative and Average. 

Equation Name 
Enter the name of the formula. %G-C is entered as default, of 
which equation is formulated in Equation Expression. 
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Equation 

Expression 

The default equation for the calculation of %G-C
(Guanine-Cytosine) base pairs is: 

 
%G-C=2.44 * ( Tm – 81.5 - 16.66 * log(M) + 500/K ) 

 
Where M is the molarities of salt in mol/L, K is the DNA base pair 

length. %G-C will be calculated with estimated Tm and input 

values, Molarities (M) and length of DNA (K). 

  
If a DNA base pair length (K) is entered as ‘0’, then the equation 
becomes: 
 
%G-C= 2.44 * ( Tm - 81.5- 16.66 * log(M) ) 

DNA Pair Length 

(K) 
Enter the DNA pair length. If a DNA pair length is above 5000, 
enter as “0”. 

Calculation Start 

Temperature (℃) 
Enter the start temperature for calculating the Tm value using the 
selected method. 

Calculation End 

Temperature (℃) 
Enter the end temperature for calculating the Tm value using the 
selected method. 

Molarity (mol/L) 
Enter the salt molarities of the solution [mol/L]. This value will be 
used calculating %G-C. 

0%T / Blocked 

Beam Baseline 
Check the 0%T/Blocked Beam Baseline checkbox when 
measuring samples with high absorbance/low transmittance. 

 

4.2 Lamp 
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Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 

Select Lamp  

               

Light Change Wavelength (nm) will be deactivated if UV or VIS 

lamp is selected. 

Light Change 

Wavelength (nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength. (360~450 nm, default setting: 400 nm) 

 

4.3 Accessory 

 

        In the Thermal Denaturation mode, select Single Cell Peliter or Multi-Cell Peltier 

accessory. 

        For more details of the Peltier Accessory temperature setting, refer to the 6-Position 

Peltier Controlled Cell Changer (09931286 or Single Cell Peltier Holder manual. 
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5. After completing parameter setup for Experiment, Lamp and Accessory, click Apply and 

then select OK. 

 
6. Input the blank into Reference and Sample holder both. Close the sample compartment 

cover and measure Baseline using Baseline  icon. Baseline will be measured when 

it reaches the set start temperature. 

NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 
7. Remove blank solution from sample cell holder and Input the sample solution into the 

sample holder. Close the sample compartment cover and then, select Sample  icon. 

The measurement will be started after the temperature reached the target temperature. 

 
8. After the measurement is finished, the results are displayed in the result window. Save or 

print results as required. 
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X-9. Scanning Kinetics Mode 

 

 Use Scanning Kinetics to test reaction rate among the specified wavelength range. Scanning 

Kinetics mode measures the changes to a sample’s absorbance, transmittance and 

reflectance over time at a specified wavelength range. 

 Perform a Scanning Kinetics Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Measure samples. 

5. Save or print results as required.  

 

 Procedure 

1. Execute the Scanning Kinetics .  

 

2. The following window will be displayed. Enter Title, Comment and select Experiment  

Type and then, select OK. 

 

 
3. Select Method. 

  

 
4. Setup the experiment, Lamp and Kinetics parameters.  
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4.1 Experiment 

  

Command Function 

X Start Value  Input the start measurement wavelength (190 to 1100 nm) 

X End Value Inputs the end measurement wavelength      

Y Unit 
Select Y unit. Absorbance (AU), Transmittance (%T), 
Reflectance (%R) or Energy 

SBW 

Select Spectral Band Width. 

 
Default is 1.0 nm. 

Data Interval (nm) 
Select Data Interval. (0.05, 0.1, 0.5, 1.0 or 2.0 nm)  
Default is 1.0 nm 

Scan Rate (nm/min) Shows the scan speed per time 

0%T / Blocked 

Beam Baseline 
Check the 0%T/Blocked Beam Baseline checkbox when 
measuring samples with high absorbance/low transmittance.
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4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type 

Single Front: Only uses Sample holder as a single beam type

Single Rear: Only uses Reference holder as a single beam 
type 

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position
as a double beam type 

Lamp 

Select Lamp: UV+Vis, UV or VIS  

Light Change Wavelength (nm) will be deactivated if UV or 

VIS lamp is selected. 

Light Change 

Wavelength (nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength. (360~450 nm, default setting: 400 nm) 
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4.3 Internal Reference 

Internal Reference is a technique that can be used to improve the precision of results by 

minimizing the effects of any changes that cause a linear baseline shift, for example a drift 

in lamp intensity. For more details, please refer to 4.3 Internal Reference in X-1-1. Scan 

Setup. 

 

 

4.4 Scan Setup 

Enter the wavelength using Insert and Delete.  
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4.5 Kinetics 

  
 

Command Function 

Wavelength (nm) Enter the desired wavelength for the Rate calculation            

Time Unit Choose a time unit either sec or min                           

Rate Calculation 

Type 

Select Calculation Type 

 

▶ Zero Order 

The zero order calculation uses a linear fit to calculate the 
rate, k, b linear regression using the equation:  
 
At = A0 + kt 
 

At is the absorbance at time t 
A0 is the absorbance at the start of the calculation time range 
k is the zero order rate constant [Units: 1/ AU∙s]  

 

▶ Initial Rate 

The initial rate calculation uses a quadratic fit to calculate the 
rate, k, by linear regression using the equation:  
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At = A0 + kt + t2

 

Where  At is the absorbance at time t 

    A0 is the initial absorbance 

        k is the initial rate [Units: AU/s] 

 

First order 

The first order calculation uses an exponential fit to calculate 

the rate, k, using: 

At = A∞+ (Ao-A∞) e
-kt

 
This rate law can be rearranged to 

ln(At A∞)= ln(Ao-A∞)  kt 

 
Where  At is the absorbance at time t 

A0 is the initial absorbance 

k is the first order rate constant [Unit : 1/s] 

 

▶Delta AU 

Delta AU is the difference between the absorbance at the start 
of the calculation time range and the absorbance at the end. 
The calculation is very simple: 
 
Delta AU = At - A0 
 

Where At is the absorbance at time t 

A0 is the initial absorbance 

Delta AU [Units: AU] 

Rate Calculation 

Start Time 
Enter the start time to calculate the reaction rate 

Rate Calculation 

End Time 
Enter the finish time to calculate the reaction rate 

Measurement 

Cycle Time Setup 
The whole measurement time can be split a number of time 
phases. Insert or delete the phase and set the time properties. 

Interval Time Enter the interval time between measurements 

End Time Input the end time for Kinetic Rate calculation 
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NOTE: User can change the rate calculation range roughly by dragging the mouse. Select Cursor 

 icon in Spectral Display Function Tool to set the range. 

 

 

4.6 Accessory 

For more details of accessory setting refer to each accessory manual. 

 

5. After completing parameter setup for Experiment, Lamp, Internal Reference, Scan Setup 

and Kinetics, select Apply and then select OK. 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU.  

NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 

a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 
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c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed 

 
7. Remove blank solution from sample cell holder and Input the sample solution into the 

sample holder. Close the sample compartment cover and then, select Sample  icon. 

The measurement will be started after the temperature reached the target temperature. 

 
8. Input sample name and select OK. 

 

 

9. If you want to stop for a while on the way of measurement, select Pause  icon. 

Resume by selecting Restart  icon.  

 
10. After the experiment is completed, confirm the result data. 

 
11. Save or print spectrum and results as desired. 
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X-10. Scanning Quantification Mode 

 

 
 Scanning Quantification mode allows quantifying the unknown samples’ concentration based 

on standards calibration curve at the specified wavelength among the one of the measured 

spectral range. 

 Use Scanning Quantification mode to quantify a sample at one of the scanned wavelength 

using a reference standard. 

 Perform a Scanning Quantification Method measurement as follows: 

1. Select measurement mode. 

2. Set method parameters. 

3. Measure Baseline. 

4. Scan with standards. Create the calibration curve using a set of standards at the specified 

wavelength. 

5. Scan samples. 

6. Save or print results as required.  

 

 Procedure 

1. Execute the Scanning Quantification .  

 

2. The following window will be displayed. Enter Title, Comment and select Experiment Type 

and then, click OK. 

 

 
3. Select Method. 

 

 

4. Setup the experiment, Lamp and Quantification parameters.  
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4.1 Experiment 

  

Command Function 

X Start (nm)  Input the start measurement wavelength (190 to 1100 nm) 

X End (nm) Inputs the end measurement wavelength      

Y Unit 
Displays Y-axis unit: Absorbance (AU), Transmittance (%T) 

Reflectance (%R) or Energy 

SBW 
Select Spectral Band Width: 0.5, 1.0, 2.0, 5.0 or 20 nm.  

Default is 1.0 nm. 

Data Interval (nm) 

Select Data Interval (Default: 1.0 nm) 

 

Scan Rate 

(nm/min) 
Shows the scan speed per time. 

0%T / Blocked 

Beam Baseline 
Check the 0%T/Blocked Beam Baseline checkbox when 
measuring samples with high absorbance/low transmittance. 

 



 

 

PerkinElmer                                         UV Express Software User Guide  107 

4.2 Lamp 

 

Command Function 

Beam Type 

Select Beam Path Type. 

Single Front: Only uses Sample holder as a single beam type 

Single Rear: Only uses Reference holder as a single beam type 

Double Normal: General uses as a double beam type 

Double Reverse: Reverses the sample and reference position 
as a double beam type 

Lamp 

Select Lamp.    

               
Light Change Wavelength(nm) will be deactivated if UV or VIS 

lamp is selected 

Light Change 

Wavelength 

(nm) 

Sets the changeover wavelength for the deuterium lamp and 
halogen lamp.  
Enter a wavelength ( 360~450 nm, default setting: 400 nm ) 
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4.3 Internal Reference  

Internal Reference is a technique that can be used to improve the precision of results by 

minimizing the effects of any changes that cause a linear baseline shift, for example a drift 

in lamp intensity. For more details, please refer to 4.3 Internal Reference in X-1-1. Scan 

Setup. 

 

 

4.4 Quantification 
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Command Function 

Setup Enter each standard concentration using Insert and Delete.

Replicates 
Select the number of replicate readings to be taken for 
each sample (1~5). The measurement is automatically 
repeated as set number. 

Sample/Std Averaging 

Select the number of reading to be taken from different 
solutions of sample/standards (1~3). 
Sample/Std has to be replaced between each count.  

 

Analytical Name Enter the file name. 

Concentration Unit Enter the unit of concentration. 

Use Wavelength (nm) Enter the wavelength to test. 

Intercept No: Calibration Curve passes through the origin 
Yes: Calibration Curve does not pass through the origin  

Fit Order Choose the calibration curve dimension: Linear, Quadratic 
or Cubic 

Limit warning 

Message 

When the measured sample value is out of calibration 
curve range, the below warning message will be shown. 
This message can be checked as optional. 

 

4.5 Accessory 

For more details of accessory setting refer to each accessory manual. 

 

5. After completing parameter setup for Experiment, Lamp, Internal Reference and 

Quantification, select Apply and then select OK. 

NOTE: You can save the method and open the method whenever you need. 

ex) Save [File] → [Save Method] and Open [File] → [Open Method] 

 
6. Input the blank solution into Reference and Sample holder both. Close the sample 

compartment cover and measure Baseline using Baseline  icon. Absorbance of 

selected wavelength is changed about 0 AU. 

NOTE: When you check the 0%T / Blocked Beam Baseline, Baseline measurement procedure is 

as follows. 
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a. Click Baseline  icon. 

b. When the below message is popped up, click OK after checking the empty of both holders 

(Reference and Sample). 

 

c. Measure the dark automatically and then, after the below message is shown. Depending 

on the sample, empty the cell holder or input the blank into reference and sample holder 

both. Click OK. 

 

 
NOTE: You should measure Baseline whenever the wavelength, SBW or Reference sample is 

changed. 

 

7. Input the Standard sample into the Sample holder and then, select the Standard  

icon. 

 
8. Measure Standard samples in order and the calibration curve will be created as follow. 
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NOTE: You can save the standard calibration curve and open the curve whenever you need. 

 

9. Input Blank and Unknown sample into each Reference and Sample holder and then, click 

Sample  icon. Click Sample after measuring [Baseline] when you opened the 

standard curve saved. 

 
10. Input sample name and select OK. 

 

 
11. Data will be shown as follows. 

 

a. Name: Shows the entered Standard or Sample name. 

b. Type: Displays the Standard or Sample. 

c. Concentration: Display the calculated concentration. 

d. AU: Displays the measured Y-axis value. 

e. Dilution factor: The dilution factor is set 1.0 as a default and it can be edited after the 
sample measurement. Double-click on the Dilution Factor to be changed in each 
sample measurement result and enter a new Dilution Factor and click OK. 

  

f. Original Conc.: Shows the original concentration of sample.  

(Original Concentration = Concentration x Dilution Factor) 

g. SD, %RSD: Shows the statistics of the repeated measures data.   

Standard/Sample Spectrum Calibration Curve 

Sample Data 

Standard Result Data Sample Result Data 
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NOTE: In case of checking on Limit warning Message in the Quantification tab of the Method 
window, the following message is shown as the sample measurement values is out of the 
calibration curve range. 

 

 

12. Save or print spectrum and results as desired. 
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XI. Display Function Tools 
 

Use the display function tools to modify the display of the main window as desired. 

 

Tool icon Function Tool icon Function 

 
Zoom Reset  Pick Peak 

 
Y Axis 

Auto Scale  
Pick Valley 

 
Add Label 

 
Cursor 

 
Edit Label 

 
To Left 

 
Properties 

 
To Right 

 

XI-1. Zoom In / Reset / Auto scale 
 
 Use these icons to zoom, reset and auto scale the selected area in the main window. 

 Procedure 

1. Select the zoom area using the mouse as shown below. 

  

 

2. To restore the original range, click Zoom Reset  or double click anywhere in Main 
Window. 

 

3. To Auto scale the Y axis, click the Y Axis Auto Scale . 
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XI-2. Add / Edit / Delete Label 
 
 Use these icons to add, edit and delete labels in the main window. 

 Procedure 

1. Click Add Label . 

 
2. Set and click the label at the required position using the mouse as shown below. 

 

3. The following dialog box will be displayed. 

 

 
4. Enter comments, and select a font style and size. 

 
5. Select OK. 

 

 
6. To edit or delete the labels, click Edit Label and edit or delete the labels as desired. 
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XI-3. Properties  
 

 Use these icons to change chart properties in the main window, such as the chart color, 

display interval, grid, X Axis, Y Axis and line properties. 

 Procedure 

1. Select Properties.  

 
2. Change properties as follows. 

 
3. Select OK when finished.  

 

a. Chart: Choose the colors of the background and Axis color.  

   Background Color: Select the main window color. 

   Axis Color: Select the spectra axis color. 

   Display Interval: Select the wavelength display interval: 0.05 nm, 0.1 nm, 0.5 nm, 1 nm, 

2 nm. 

 

b. Legend: Select to display the legend on the chart and where to position it. 

   Show: Select Yes or No. 

   Location: Select the legend position; Top, Bottom, Left or Right. 

 

c. Grid: Select to display X and Y grids. 

   Pattern: Select a grid pattern; None, Solid, Long Dash, Dotted or Short Dash. 

   Width: Set the grid width. 

   Color: Select grid color. 

   X Space: Set the space of X-axis.  

   Y Space: Set the space of Y-axis. 
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d. X Axis: Set the range of X Axis. 

   Min. and Max.: Set the range of X-axis. 

   Decimal Point Format: Set the decimal point (1~9). 

 
e. Y Axis: Set the range of Y Axis. 

Auto Scale: Select Yes or No. 

Min. and Max.: Set the range of Y-axis 

   Decimal Point Format: Set the decimal point (1~9). 

 
f. Line: Select the color and pattern of the spectrum lines. 

   Pattern: Select a grid pattern; None, Solid, Long Dash, Dotted or Short Dash. 

Width: Set the line width. 

   Color: Select line color. 

 
 

XI-4. Pick Peak / Valley 

 

 Use these icons to pick peaks/ valleys or seek the data. 

 Procedure 

1. Select Pick Peak/ Valley.  

 
2. Select the spectral range using the mouse. The labels of the peaks or valleys are displayed    

as shown below. 

   
3. To delete a peak/valley, select the peak/valley in the result window and select the right    

mouse.  

 

 

4. Select delete or delete all as shown below. 
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XI-5. Cursor / To left / To right 

 
 Use these icons to display the cross lines for selecting data points.  

 Procedure 

1. Select Cursor .  

 

2. Wavelength and absorbance (Transmittance or reflectance) value will display in the result 

window. User can move the cursor using To left or To right icon. 

 



 
 

118  UV Express Software User Guide                                         PerkinElmer 

 
 

 

 

 

 

 

 

 

 
 


